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PhotoTools

Introduction
Welcome to Extensis PhotoTools. You’ve just purchased a collection
of plug-ins that enable you to work faster, easier and more efficiently
in Photoshop®. PhotoTools was designed to address the everyday needs
of Photoshop users. Whether you’re creating artwork for a Web page
or adding special effects to an image, PhotoTools increases your
efficiency. PhotoTools enhances Photoshop by improving its usability.

The PhotoTools menu item, appended to the right of your Photoshop
menu items, offers convenient access to PhotoTools plug-ins. For
example, each of the four PhotoEffects (Bevel, Emboss, Glow and
Shadow) appears in this menu, along with submenus of effect sets that
you’ve custom created and saved.

The eight plug-ins in PhotoTools share a consistent user interface and
are designed and tested to work smoothly with Photoshop 3.0.4 and
later. We believe you’ll find PhotoTools a natural extension of
Photoshop. PhotoTools and Photoshop—standard equipment for
creative professionals.

System and Software Requirements
To use PhotoTools, you need the following software:
• Apple® Macintosh® System 7.1.1 or later 
• Photoshop 3.0.4 or later

Installation
Before installing, turn off any anti-virus software and extensions,
except for your CD-ROM extensions. Then restart your computer. 

1. Insert the disk that came with your product.
If you received a CD-ROM version, you will notice that other
Extensis products are available for you to install. These products
are full working versions of Extensis products that you can run in
Demo mode.

2. Double-click the installer icon.
The Introduction dialog box appears.

3. Click the Continue button.
The Welcome dialog box appears. Release notes and special
instructions are displayed in this window. It is important that you
read these release notes since they contain information not
included in the manual. You should save or print these release
notes before continuing the installation.

4. Click the Continue button.
The Installation dialog box appears. 

5. Click the Install button.
The Disk Selection dialog box appears. The dialog box requests
that you select the disk on which you want the Extensis product
installed.
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6. Select a disk.
Once a disk has been selected, you will need to locate the
application into which you want to install the Extensis product.

7. Select an application.
8. Click the Select button.

Once installation is complete, the successful installation dialog
appears. The installer will prompt you to restart your computer if
necessary.

Registration
It is important to register your copy of PhotoTools so we can provide
you with service. Registered users of PhotoTools are eligible for
technical support, information regarding new versions, products,
discounts and special offers on new products.

PhotoTools includes electronic registration, so registering has never
been easier! The first time you launch Photoshop after installing
PhotoTools, the PhotoTools Personalize dialog box appears. To
personalize PhotoTools, type your name, company and PhotoTools
registration number. Your product registration number is located on
your PhotoTools manual. If you choose not to personalize your copy,
PhotoTools will run in a 30-day demonstration mode. A dialog box
will remind you of how many days are remaining in the demonstration
mode.

Once you have personalized PhotoTools, a dialog box appears, asking
if you would like to register. To register PhotoTools, click the Register
PhotoTools button and an electronic registration screen appears. After
you’ve completed the registration screen, a Market Research screen
and a System Configuration screen will follow. The Market Research
screen asks basic questions that enable us to better understand your
needs. The System Configuration screen provides a “snapshot” of your
system configuration that enables Extensis to support you more
effectively. Sending the Market Research and System Configuration
information is optional. If you don’t want to send this information to
Extensis, you may check the checkbox at the bottom of these screens. 

If you have a modem connected to your computer, you can register
toll-free by modem. If you do not have a modem, you can print the
registration sheet and register either by faxing it to (503) 274-0530 or
drop it in the mail in the postage-paid envelope provided. If you don’t
have access to a modem or printer, you can still register by filling out
a registration sheet located at the end of this manual. 
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Technical Support
For questions regarding PhotoTools, please first refer to this manual,
which describes the features and basic operations. If you have a 
question or problem that is not addressed in the Troubleshooting
section or the manual, technical support is available by calling 
(503) 274-7030, Monday through Friday, between the hours of 8:00
a.m to 5:00 p.m. Pacific time. 

When calling technical support, please be at your Macintosh and have
the following information available: your PhotoTools registration
number, your Macintosh configuration and your question or a
description of the difficulty you’re experiencing—what specifically
occurs and when. Take note of any displayed error numbers or
messages and any other information you think may be relevant.

Suggestions
We’d love to hear your comments about PhotoTools, ideas for new
plug-ins or improvements on existing plug-ins. A suggestion sheet is
included at the end of this manual. Please fax or mail your comments
and suggestions to Extensis.
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Tip

We can also be reached via fax
at (503) 274-0530, or through
the online services listed below.

CompuServe: 70242,33
America Online: EXTENSIS
E-Mail: support@extensis.com
Web: http://www.extensis.com



PhotoBars

PhotoBars brings one-click convenience of toolbars to Photoshop,
offering instant access to hundreds of Photoshop commands and
menus. Several preconfigured toolbars are provided that include tools
and commands that any Photoshop user will find immediately useful. 

But since not all users are the same, PhotoBars gives you the power to
customize toolbars by adding, removing or arranging buttons to your
preference. Also, toolbars can be displayed or hidden as needed. For
example, you can create a toolbar specifically for rotating images, but
keep it hidden until needed. 

PhotoBars even allows you to create custom buttons for accessing
Photoshop menus, files, folders and other applications through the
toolbar. For example, files and folders or an application (such as
Adobe Illustrator) can be launched through toolbar buttons. PhotoBars
gives you the power to work more efficiently by putting the
commands you use most, right at your fingertips.

PhotoBars SmartBar
SmartBar automates the task of creating buttons and toolbars by
watching and recording your menu selections. Just turn on the
SmartBar option and SmartBar begins watching you work. As you use
Photoshop menu commands, SmartBar creates a corresponding list of
buttons (up to 15). With a click of a button, you can convert these
SmartBar buttons into a toolbar. Then, instead of searching for a
command in a menu, just click a toolbar button.

To turn on or off SmartBar:

• From the PhotoTools menu choose PhotoBars and then Show
SmartBar. 
SmartBar immediately begins watching you work and creates a
button for each menu command you select. (“Watch Me” only
functions when SmartBar is open and Watch Me is turned on.) You
can turn SmartBar on and off by clicking the “Watch Me” button
in SmartBar.

To see SmartBar options:

• Click the arrow above the SmartBar scroll bar. 
A pop-up menu appears, displaying a list of options. The first three
options correspond to the buttons along the top of the SmartBar
palette. The fourth option allows you to hide the toolbar at the top
of the SmartBar palette. The final option allows you to turn on and
off Hot Help.
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File menu commands
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Displaying and Hiding Toolbars

To Display or Hide toolbars:

1. Choose PhotoBars from the PhotoTools menu.
A submenu of toolbars appears. Checked toolbars are visible.

2. Choose a toolbar from the list. 
Selecting an unchecked toolbar displays it; selecting a checked toolbar
hides it.

Resizing and Embedding Toolbars

To move a floating toolbar:

• Click and drag the toolbar’s title bar or any gray area around the
buttons and move the toolbar to the desired location.

To resize a floating toolbar:

1. Position the cursor over the resize box at the bottom right corner
of the toolbar.

2. Click and drag the toolbar in any direction.
The cursor displays as a two-way arrow and an outline appears as the
toolbar is resized. As you drag, the outline indicates the toolbar’s new
size which snaps to fit the buttons. 

To embed a floating toolbar:

• Drag the floating toolbar to the top, bottom, left or right side of the
screen.
When you release the mouse button, the toolbar embeds into the side of
the screen.

To detach an embedded toolbar:

1. Position the cursor’s pointer in the gray area surrounding the
buttons.

2. Drag the toolbar away from the edge of the window.
The embedded toolbar becomes a floating palette with a title bar.
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Tip

Hot Help enables you to hold
the cursor over any toolbar
button to instantly view a
button’s description. This is
useful for discovering any
button’s function.

Tip

Double-clicking the title bar 
or gray area around toolbar
buttons embeds a floating
toolbar to the edge of the
screen. Double-clicking an
embedded toolbar detaches 
it to become a floating toolbar.
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Creating and Editing Toolbars

To automatically create buttons and toolbars using SmartBar:

• Click the “Build Bar” button to create a toolbar containing
all buttons listed. Or, select one or more buttons in the
SmartBar palette using the Shift key and click the “Build
Bar” button. 
A PhotoBar containing the SmartBar buttons is automatically
created for you.

To drag a button from the SmartBar to another toolbar:

• Hold down the Command key, select a button, drag it to the
desired toolbar and release the mouse button.

To clear the SmartBar button list:

1. Click the “Reset List” button. 
2. To empty the button list in SmartBar, click OK in the dialog

box that appears.

To manually create and edit toolbars:

1. From the PhotoTools menu choose PhotoBars and then Edit
Toolbars or click the Edit Toolbar button on a toolbar. 
The PhotoBars dialog box appears. A list of available toolbars is
displayed. A checkmark to the left of the toolbar name indicates
the toolbar is visible. To hide a toolbar, click on the checkmark.
The toolbar and checkmark disappear.

• To create a new toolbar, click the New button.
• To duplicate a toolbar, highlight a toolbar and click the

Duplicate button. 
A New Toolbar Name dialog box appears. Once the toolbar is
named, the new toolbar will include the same buttons as the
original.

• To rename a toolbar, highlight a toolbar and click the
Rename button.
Type a new name in the dialog box that appears.

• To delete a toolbar, highlight a toolbar and click the Delete
button.

The Edit Toolbar button

The Build Bar button

The Reset List button
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The highlighted toolbar is deleted.
• To customize a toolbar, click the Customize button to access the

Customize Toolbars dialog box.

Adding and Deleting Buttons
A toolbar needs to be visible before adding or deleting toolbar buttons.

To add buttons to a toolbar:

1.  From the PhotoTools menu choose PhotoBars and then Customize
Toolbars.
The Customize Toolbars dialog box appears.

2.  Select a Category. 
Once a Category is selected, the buttons from that category appear in
the Buttons field. If you hold your cursor over a button, the
Description field displays the button’s description.

3.  Click and drag a button to the toolbar.
Once the button is dragged onto the toolbar, the toolbar will update to
display that button on the toolbar. 

To delete buttons from a toolbar:

• Toolbar buttons can be deleted by holding down the Command
key while dragging a button off a toolbar or by selecting a button
and pressing the Delete key while the Customize dialog box is
open. 

Tip

To delete buttons without
opening the Customize
Toolbar dialog box, simply
drag a button off a toolbar
while holding down the
Command key.

Tip

To instantly create a new 
toolbar, simply drag a button
to the desktop.

A The Categories field displays a list of available
categories. Each category contains its own set
of buttons. For example, the Image menu
category displays buttons that represent the
commands available from the Photoshop Image
menu.

B The Buttons field displays buttons for the
currently selected category. Holding your cursor
over a button displays a description of the
button in the Description field. Buttons can be
dragged from the Buttons field and added to
any new or existing toolbars.

C The Description field displays a description of
the button over which the cursor is positioned.

D New Button displays the Edit Custom Button
dialog box. You can create new buttons to
access keystroke commands, menu items and
Finder items.

D

B

A

C

The Customize Toolbars dialog box
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Moving and Adding Space Between Buttons
Moving and adding space between buttons enables you to customize
toolbars and group similar function buttons.

To move buttons on a toolbar:

1.  Open the Customize Toolbars dialog box.
2.  Select the button you want to move and drag it to a new location on

the toolbar.
When you release the mouse button, the button appears in its new
location. You can also move buttons to other toolbars simply by
dragging the button to a toolbar.

To add space between buttons on a toolbar:

1.  Open the Customize Toolbars dialog box.
2.  Drag a button slightly to the right on a horizontal toolbar or down

on a vertical toolbar.
The button appears inverted as it is selected and dragged. When the
mouse button is released, space is inserted before the selected button.
Dragging a button slightly to the right or left (horizontal) or up or down
(vertical) inserts or removes space accordingly. Repeat this process to
add double space between buttons. 

Creating Your Own Buttons
You can create buttons for keystroke commands, filters, Photoshop menus,
files or folders and other applications. For example, you can create a
button to access the Image menu, a Photoshop file or folder or launch your
favorite application through a PhotoBars toolbar button.

To create a New button:

1. Open the Customize Toolbars dialog box.
2. Click New Button.

The Edit Custom Button dialog box appears. You can create 
buttons for Keystroke commands, Menu items and Finder items. 

To create a keystroke command button:

1. Click the Select button in the Edit Custom Button dialog box.
A dialog box appears for entering a keystroke.

2. Type the desired keystroke combination and click OK. 
Whenever you select the button, the keystroke will be activated.

Tip

To open the Customize
Toolbars dialog box directly,
use the Customize button on
the PhotoTools toolbar.

The Customize button

Tip

To move or modify a button’s
spacing without opening the
Customize Toolbars dialog
box, hold down the Command
key while dragging a button.
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To create menu buttons: 

1. Click the Menu radio button.
A pop-up menu appears to the right of the menu radio button. This
pop-up allows you to scroll through the menus to choose a menu to
attach to the custom button. 

2. Select a menu or menu item.
If you choose a drop-down menu, the button will display the entire
menu that was selected.

To create buttons for files or folders: 

1. Click the Finder Item radio button.
A dialog appears, asking if you want to attach a file or folder to the
custom button. If you attach a folder, it will display the contents of the
folder as items in a pop-up menu.

2. Select the file or folder option.
A dialog box appears so you can find the appropriate file or folder on
your hard drive.

3. Select the file or folder you want to attach.
Once a file or folder is selected, it or its contents will be directly
accessible through this button. 

To select an icon for a custom button:

1.  Open the Customize Toolbars dialog box. 
2. Click New Button or double-click an existing custom button.
3.  Click the Select Icon button.

The Define Icon dialog box appears. Select an icon from the 
sample icons provided, design your own icons using any Macintosh
paint program or copy and paste images from other documents. Once
a custom designed icon is pasted from the Clipboard, PhotoBars
automatically adds an icon border. 

4. Select an icon and click the Define button.

To create icons in Photoshop:

1. Select a part of an image you wish to make into an icon and
choose Copy in the Edit menu.

2. Go to the Finder and then back into Photoshop.
3. Open the Custom Toolbars dialog box. Then click the Customize

button (or double-click an existing custom button), click the New
Button and the Select Icon button. 

4. Click the Paste button.

Tip

For best results, custom
designed icons should be 
19 x 17 pixels (width/height). 

Tip

You can use the Menu radio
button in the Customize dialog
box to create buttons that will
access your Photoshop filters.
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PhotoText
PhotoText is a fully featured text layout system for creating and formatting
text within Photoshop. The PhotoText dialog box displays a resizable,
zoomable preview of your Photoshop background or layer image,
conveniently surrounded by a collection of PhotoText tools. Everything you
need to add, manipulate and position text is contained within the PhotoText
dialog box. You can even create multiple text blocks. You will also notice
that PhotoText also incorporates commands in the pull down menus. 

Use the PhotoText dialog box to place text, add color and character styles
and adjust leading, font size, tracking/kerning, character width and
alignment. Since you can see your current image (if you’re using PhotoText
on the Background image layer), you can position text blocks exactly
where you want them. You’ll enjoy the added benefit of immediately
seeing your results as you take advantage of PhotoText’s tools.

A The Apply button adds the text in the PhotoText
dialog box to the active later or image of the
Photoshop window. The text is placed in
Photoshop as a Floating selection.

B The “Cancel” button exits the dialog box without
applying your changes.

C The Text tool button changes your cursor to an
I-beam for creating, selecting and editing text.
You can define your text block while in the Text
tool mode by clicking and dragging the mouse.
The “Arrow” button changes your cursor to an
arrow for resizing or moving text blocks.

D The “Zoom” button changes the cursor to a
magnifying glass. Use the Option key to zoom
in or out.
The “Eyedropper” button picks up a pixel of
color from your image for applying to text.

E “Fill Color” displays the currently selected text
color. It also provides a pop-up color menu that
has access to Photoshop’s color picker, as well
as the current Foreground and Background
colors.

F The “Text Anti-Alias” option smooths the edges
of text created in larger font sizes.

G The pixel value numbers indicate the color in
the pixels that you move the eyedropper over.

H The X and Y numbers indicate your cursor’s
position on the screen.

I The “Fonts” pop-up menu contains a list of
available fonts. The current font name appears
in the pop-up menu.

J The “Styles” buttons control character styles:
Normal, Bold, Italics, Underline, Outline,
Shadow, Small Caps and All Caps.

K The “Alignment” buttons control the justification
settings of text within the entire text block: Left,
Right, Center and Full.

L The “Size” pop-up menu and text field adjust
the font size of selected text.

M The “Leading” pop-up menu and text field
adjust the space between lines of selected text.

N The “Tracking” pop-up menu and text field
adjust the space between selected characters.

O The “Character Width” pop-up menu and text
field adjust the width of selected characters.

P The Preview Area shows a sample of the text
before you add it to your image.

Q The grow box resizes the dialog box and
preview.

R Click the Extensis logo for information on

L

F

The PhotoText dialog box

A

C
D

H

G

I J OM N P

B

K

E

R

When the
PhotoText dialog
box is open, you
see menus
containing
PhotoText-
specific options.
For example,
the PhotoText
menu contains
the Export
Selected Text
Blocks option.

Tip

To create a text block, click
and drag the text tool I-beam
in the Preview Area.

Q
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Opening and Using PhotoText

To open the PhotoText dialog box:

• Choose PhotoText in the PhotoTools menu in the Filters menu or
choose PhotoText in the PhotoTools menu.

To create a text block:

• With the Text tool selected, click anywhere in the PhotoText dialog
box. You can also click and drag to define a text block with exact
bounding borders. Then release the mouse button and begin
typing.
For precise text block positioning, use the cursor coordinate
information, displayed in the lower left corner of the dialog box.

To add text to a text block from another application:

1. In the other application, select text and choose Copy in the Edit
menu.

2. Open Photoshop.
3. Select PhotoText in the PhotoTools menu in the Filters menu or

choose PhotoText in the PhotoTools menu.
4. Use the text Tool to position the insertion point in a text block.
5. Choose Paste in the Edit menu.

To move a text block:

1. Click the “Arrow” tool in the PhotoText dialog box.
2. Click a text block and drag it to its new position.

You can also move a text block after placing it in the Photoshop
window.

To manipulate text, you have two options:

Option 1
1. Click the “Text” tool in the PhotoText dialog box.
2. Select the text you want to change.

You can select text using the Text tool, or you can use the Arrow tool
to select an entire text box.

3. Use the tools in the PhotoText dialog box to modify the
appearance of the text.

Option 2
1. Click the “Arrow” tool in the PhotoText dialog box.
2. Select the text block(s) you want to modify.
3. Use the tools in the PhotoText dialog box to modify the

appearance of the text.

To save text you have created in PhotoText:

1. Select the text block(s) with the “Arrow” tool.
2. Choose Export Selected Text Blocks from the PhotoText menu.

Your text will be saved as a SimpleText document on your hard drive.

The Text tool

The Arrow tool

Tip

While the Text tool is active,
you can hold down the Option
key to temporarily change to
the Arrow tool. Also, press the
Command-Tab keys to toggle
between the Arrow and Text

Tip

You can change most text
attributes on individual
characters or the entire text
block. Use the Text tool to
make changes on a character
level, or the Arrow tool to
make changes to the entire
text block.

Tip

To adjust the space between
two characters (kerning),
position the insertion point
between the two characters.
Then adjust the value in the
tracking field.
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To apply text to a Photoshop image:

• Once the text in the PhotoTools windows appears as you want it,
click the Apply button.
Your text will be returned as a floating selection in the Photoshop
window.

Adjusting the Text Attributes
You can use the following keyboard shortcuts to adjust text attributes: 

1 pt. Font size = Cmd-Shift->  (increase); Cmd-Shift-<  (decrease)
1 pt. Leading = Cmd-Shift-”  (increase); Cmd-Shift-:  (decrease)
1 pt. Tracking = Cmd-Shift-}  (increase); Cmd-Shift-{  (decrease)
1% Character width = Cmd-]  (increase); Cmd-[  (decrease)

Note: PhotoText remembers the last used font and most attributes when
creating a new text block or opening PhotoText in a new session.

The Apply button

Tip

You can convert a floating
selection into a layer by
double-clicking or option-
double-clicking on it in the
Photoshop Layer palette.
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Intellihance Lite

Intellihance Lite is a condensed version of Extensis’ Intellihance 2.0 for
Photoshop. Intellihance Lite improves the way your RGB digital images
appear in print or on the screen by intelligently analyzing each image’s
needs and then automatically applying filters for contrast, brightness,
saturation, sharpness and despeckle. All you need to do is click the
Enhance Image button.

Although we believe Intellihance’s default preferences will satisfy the
majority of users, you can customize the way Intellihance applies filters—
choose exactly how you want the intelligent enhancement engine to
analyze and enhance each image.

Note: The full Intellihance product works on grayscale and CMYK images
as well as RGB and includes a Fine Tune option for manually tweaking
images. It provides a Preview screen in which you can view your original
image and the enhancements that Intellihance proposes to make when you
process it as well as previewing preference settings changes. Intellihance
also allows you to save and load custom preference settings and run in
batch processing mode with QuicKeys and Photomatic. If you’d like to
learn more about Intellihance or order the full product, call Extensis at 
1-800-796-9798.

Customizing Intellihance Lite
Clicking the Preferences button in the Intellihance Lite dialog box displays
the Intellihance Lite Preferences dialog box. Using the pop-up menus of
preferences, you can customize the way Intellihance applies the contrast,
brightness, saturation, sharpness and despeckle filters. 

Intellihance analyzes and compares your original image to the output
settings you’ve chosen—and then automatically processes the image to
match your preferences. 

A Intellihance will start processing the current
image with the output settings defined in the
Preferences dialog box (Return).

B Exits Intellihance with no changes (Command-
period).

C The Reset button reverts the selections in the
pop-up menus to their original settings.

D Pop-up menus containing preferences that
determine how the intelligent enhancement
engine will optimize your image.

D

The Intellihance Lite Preferences dialog box

A

B

B
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To customize Intellihance Lite:

1. Choose Intellihance Lite in the PhotoTools menu.
The Intellihance Lite dialog box appears.

2. Click the Preferences button.
The Intellihance Lite Preferences dialog box appears.

3. Determine the way you want your output to appear and make
those selections from the menus in the Intellihance Lite
Preferences dialog box.

4. Click OK and then Enhance Image to apply the changes. 
Then you can apply the same set of preferences to multiple images.
Click Reset in the Intellihance Lite Preferences dialog box to revert to
the original settings.

Adjusting Intellihance Filters
You can adjust five separate filters from the Intellihance Preferences
screen. Each filter has a menu of predefined effects. 
• Contrast
• Brightness
• Saturation  
• Sharpness
• Despeckle

Contrast
The Contrast filter gives you four options for adjusting tonal correction.
The Normal option brightens highlights, darken shadows and establishes
midtones for best overall contrast. Select the Soft option if you want to
maintain maximum shadow and highlight detail or if you want to lower
contrast overall. Select the Snappy option if you want your image to have
solid blacks and solid whites or to increase contrast. Select the Hard
Contrast option if you want images with high contrast or if you want a
posterized effect. If you don’t want any correction, you can turn this filter
Off. 

Two additional options are available for special publishing applications.
Flatten Highlights may be useful when printing on newspaper to allow
you to use the paper itself to represent the highlight in the image. Flatten
Shadows may be useful when you want to push some shadow noise into
the blacks.

Brightness
The Brightness filter adjusts or shifts various tonal groups. You can shift
shadows, midtones or highlights or balance the overall tone of the image.
This means, for example, that Intellihance can darken overexposed
photographs and lighten underexposed photographs. If you don’t want
any correction, you can turn this filter Off. 

Brightness is a subjective adjustment. Try each of the settings for the
Brightness filter and see what you like best. After running the settings on
several images, you’ll discover which setting provides the most desirable
results.
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Saturation
The Saturation filter is a color adjustment filter for automatically adjusting
the purity of the color. The Medium option provides excellent results for
most images. Intellihance automatically examines the saturation of the
input image and then increases or decreases the saturation according to the
setting for this filter. This is very useful with Photo CD images that are
often oversaturated. If you don’t want any saturation correction, you can
turn this filter Off. 

Saturation processing increases the computing time. Unless you have a
powerful Macintosh, you might want to allow extra time to process images
that need more saturation.

Sharpness
The Sharpness filter sharpens soft images by increasing the contrast of
adjacent pixels. Like Brightness, Sharpness is also subjective. Try each of
the settings for the Sharpness filter on several images and see what you
like best. If you don’t want any correction, you can turn this filter Off.
Remember, the Sharpness filter will not sharpen noisy images.

Despeckle
The Despeckle filter removes noise, such as photograin or scanner-induced
noise, while preserving detail. Intellihance detects the edges in an image
(the areas where significant color changes occur) and gently smooths all of
the selection except those edges. 

If you want to reduce image noise, this filter has three options that process
only noisy pixels without changing highlights or other details. 
The Overall option is useful for situations where the image may contain
speckles or photograin noise in the image. The Dark Tones Only option is
for images where you’re satisfied with your light tones and only need to
adjust dark tones. The Light Tones Only option is for images you might
enlarge such that the photograin in the highlights becomes evident. These
last two options allow you to limit the filtering to the darker or lighter
areas of the image. If you don’t want any correction, you can turn this
filter Off.



16

PhotoTips

PhotoTips & Tricks offers hundreds of valuable Photoshop tips and tricks
from Photoshop expert Deke McClelland, author of The Macworld
Photoshop 3 Bible. These tips will help you use Photoshop more
productively. If you click the “Show tips at startup” checkbox, a new
Photoshop tip is displayed each time you start up Photoshop. 

Reading PhotoTips

To view tips at any time:

1. Choose PhotoTips from the PhotoTools menu.
You see the Tips & Tricks dialog box. 

2. Click the Next Tip button to read the next tip.

To search for tips by topic:

1. Click the More Tips button in the Tips & Tricks dialog box. 
You see the More Tips dialog box. 

2. In the Find field, type the text for which you want to search.
3. Click Find to see the tips matching your text.

Click Find All to reset the list and see all tips and tricks.
4. Select a tip title and click View to read it.

A The Tip dialog box displays Photoshop tips
in a scrolling field.

B The Next Tip button enables you to view
an additional tip. Clicking this button
displays the next tip in the series.

C The More Tips button displays a dialog box
that shows all available tips by their title.
You can quickly browse or find tips by
topic.

D The “Show tips at startup” checkbox
displays a new tip each time you open
Photoshop.

E The Find field allows you to enter text for
which you want to search.

F The Find button displays all topics
matching your search criteria. The Find All
button resets the list to display all topics.

G The View button displays the selected tip
in the Tip dialog box.

B
A

D

C

The PhotoTips & Tricks dialog boxes

Tip

Holding down the Option key
changes the Next Tip button
to Previous Tip.

E

G

F



PhotoEffects
PhotoEffects is a set of four Photoshop image enhancement tools,
consisting of PhotoBevel, PhotoEmboss, PhotoGlow and PhotoShadow.

Using PhotoEffects

To create an effect using PhotoEffects:

1. Select an area of your image to which you want to add an effect.
2. Choose the desired effect from the PhotoTools menu in the Photoshop

Filters menu, from the PhotoTools menu in the menu bar or in the
PhotoBar.
Select either PhotoBevel, PhotoEmboss, PhotoGlow or PhotoShadow.
You see the dialog box for the effect you selected.

3. Use the options in the dialog box to create the desired effect
(explained later in this chapter). 

4. To preview the effect as you adjust the settings, click the Auto
Preview checkbox. Or, you can preview the effect anytime by
clicking the Preview Now button.
The preview of the image containing the effect appears in the Preview
Area of the resizable dialog box.

5. Click Apply to add the effect to your image.
If you are applying an effect that creates pixels outside of your original
selection area, you see a dialog box warning you that your selection
will be permanently lost upon applying the effect. (This applies to
PhotoShadow, PhotoBevel outer bevels and PhotoEmboss raise, edge
and blur.) To retain your selection:

• Click Cancel in the warning dialog box to return to the Effect dialog
box and then save your settings. (See below.) 

• Click Cancel.
• Choose Save Selection from the Select menu.
• Open the PhotoEffects dialog box and apply the effect.
• After you have run the PhotoEffects filter, you can restore your

selection by choosing Load Selection from the Select menu.

To save PhotoEffects settings for later use:

1. Once you’ve established the settings exactly as you want them,
click the Save button in the effect’s dialog box.
A Save dialog box appears, allowing you to name and save the current
effect’s settings.

2. Type a name for the settings. 
3. Click Save.

The name of the new settings appears in the pop-up menu toward the
bottom, left corner of the dialog box.

17

PhotoEffects

Tip

PhotoBars
provides a
quick,
convenient
way to
access
previously
saved
effects.
Click the
Saved Effects button in the
Effects Settings toolbar to see a
list of all saved effect sets.
Choosing a set in this list
immediately applies the effect to
the selection.

Tip

If you’re working with a
floating selection and wish to
preview it with the background
image, choose “Defloat”
(Command-J) from the
Photoshop Select menu
before opening your
PhotoEffects filters.



To use PhotoEffects settings that you’ve saved:

1. Select an area of your image to which you want to add an effect.
2. Choose the desired effect from the PhotoTools menu in the

Photoshop Filters menu.
Select either PhotoBevel, PhotoEmboss, PhotoGlow or PhotoShadow.
You see the dialog box for the effect you selected.

3. Choose the name of the saved effect in the pop-up menu in the
bottom, left corner of the dialog box.

4. If desired, make any additional adjustments to the effect.
5. Click Apply to add the effect to your image.

If you are applying an effect that creates pixels outside of your original
selection area, you see a dialog box, warning you that your selection
will be permanently lost upon applying the effect. (This applies to
PhotoShadow, PhotoBevel outer bevels and PhotoEmboss raise, edge
and blur.) To retain your selection:

• Click Cancel in the warning dialog box to return to the Effect dialog
box and then save your settings. (See below.) 

• Click Cancel.
• Choose Save Selection from the Select menu.
• Open the PhotoEffects dialog box and apply the effect.
• After you have run the PhotoEffects filter, you can restore your

selection by choosing Load Selection from the Select menu.

To remove PhotoEffects settings that you’ve saved:

1. Choose the desired effect from the PhotoTools menu in the
Photoshop Filters menu, from the PhotoTools menu in the menu bar
or in the PhotoBar..
Select either PhotoBevel, PhotoEmboss, PhotoGlow or PhotoShadow.
You see the dialog box for the effect you selected.

2. Choose the name of the saved effect that you want to remove in
the pop-up menu in the bottom, left corner of the dialog box.

3. Click the Delete button.
A dialog box appears, asking you to confirm the deletion of the saved
effect.

5. Click Delete.
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Tip

You can apply a saved effect
in three ways: select it in the
effect’s dialog box, select it in
the PhotoTools menu or click
the effect’s button that comes
with PhotoBars.

Tip

You can speed up your
preview refresh by selecting
the Preview Work Area Only
checkbox.
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PhotoBevel
Bevels give the selected part of your image a raised appearance by
applying highlights and shadows to its inside and outside edges.

PhotoBevel provides several tools for adding a bevel to an image. In
addition to choosing whether the bevel is applied to the inside or outside
edge of the selection area, you can select one of the four different bevel
shapes (Flat, Round, Slope or Double) and control bevel edge tolerance. A
Softness option is useful for softening the bevel edge and controls for the
highlight and shadow intensity are at your fingertips. Selecting the
direction of the light is as easy as entering a number or spinning the
directional ball with your mouse.

A The Preview Area shows a sample of the Bevel
options before you apply them to your image.

B The Bevel Type pop-up menu contains an Inner
and Outer Bevel option. The Outer Bevel option
is only active if you’ve selected less than the
entire image. The Bevel Shape pop-up menu
controls the shape (either Flat, Round, Slope or
Double) of the bevel.

C Edge Tolerance refers to feathered selections.
This option allows you to control which pixels
PhotoEffects considers the edge. Maximum
uses all of the feathered pixels when defining
the bevel area; Minimum doesn’t use any
feathered pixels; Medium uses half of the
feathered pixels when defining the bevel area.

D Width determines the width of the bevel.
Softness is similar to a blur. This option softens
the transition points between light and dark.

E Balance adjusts the balance between the
Highlight and the Shadow of the bevel.
Highlight Intensity and Shadow Intensity control
the strength of the bevel highlights and shadows.

F The Light Direction field indicates and adjusts
the direction of the light source.

G The color pop-up palettes for the bevel’s
highlight and shadow includes an assortment of
colors, access to Photoshop background/
foreground colors and the Apple Color Picker.

H See the entire image in the Preview Area when
the Preview Work Area Only checkbox is not
selected. See only the selected part of the
image when the checkbox is selected. Selecting
the checkbox increases preview refresh
performance.

I Selecting the Auto Preview checkbox
immediately shows changes to your created
effect. The Preview Now button is only active
when the Auto Preview checkbox is not
selected. When you click this button, the
Preview Area updates.

J The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved bevel sets appear in the
Bevel pop-up menu. Selecting a saved effect
displays its settings in the dialog box. You can
then apply these bevel settings to the current
image.

K Zooms in and out.
L The Apply button adds your created effect to

the image and closes the Bevel dialog box.
M The grow box resizes the dialog box and

The PhotoBevel dialog box
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PhotoEmboss
PhotoEmboss works like no other embossing tool. Its unique control and
emboss styles give you the ability to create cutouts, embosses, reliefs,
recesses and many other special effects.

PhotoEmboss includes options for selecting the emboss type, along with
the amount of embossing. You control the contrast, softness, highlight and
shadow of the embossing. In addition, you can position a directional light
source and customize the color of the emboss highlight and shadow.

A The Preview Area shows a sample of the
PhotoEmboss options before you apply them to
your image.

B The Emboss Type pop-up menu provides four
options:

Cutout typically pushes in the selection area.

Raise typically pushes out the selection area.

Edges applies the highlight and shadow
emboss colors around the inside and outside of
the selection edge. This effect more
dramatically defines the selection edge.

Blur creates an off focus, fuzzy emboss.

Invert changes emboss effect 180 degrees.

C Amount indicates the width of the emboss.

D Contrast controls the amount of difference
between lightness and darkness in the emboss. 

E Softness is a blur type setting to diffuse the
transition from light to dark.

F Highlight controls the strength of the emboss
highlights.

G Shadow controls the darkness of the emboss’
shadow edge.

H The Light Direction field indicates and adjusts
the direction of the light source.

I The color pop-up palettes for the emboss’
highlight and shadow include an assortment of
colors, access to Photoshop background/
foreground colors and the Apple Color Picker.

J See the entire image in the Preview Area when
the Preview Work Area Only checkbox is not
selected. See only the selected part of the
image when the checkbox is selected. Selecting
the checkbox increases preview refresh
performance.

K Selecting the Auto Preview checkbox
immediately shows changes to your created
effect. The Preview Now button is only active
when the Auto Preview checkbox is not
selected. When you click this button, the
Preview Area updates.

L The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved emboss sets appear in the
Emboss pop-up menu. Selecting a saved effect
displays its settings in the dialog box. You can
then apply these emboss settings to the current
image.

M Zooms in and out. 

N The Apply button adds your created effect to
the image and closes the Emboss dialog box.

O The grow box resizes the dialog box and

The PhotoEmboss dialog box
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PhotoGlow
As an artist, imagine creating an image of a neon sign or a candle. You’d
typically add a glow effect around the outer edges of the neon sign and
around the candle’s flame. PhotoGlow makes this process easy. In addition,
it allows you to add a solid stroke around any selection.

Adding a glow is as easy as selecting the object and experimenting with
PhotoGlow’s tools. You can apply a solid glow to the selected image or just
to its edges. You determine how far the glow should extend and determine its
radiance (the glow’s diffusion). In the above candle example, you could
apply a high radiance for a soft, subtle glow or a low radiance for an intense,
hard, bright glow. Also, the glow opacity (or how much the glow is allow to
show through) is at your control. A good use of opacity is on images
containing light text applied to a light background. After choosing a glow
color darker than the background, increasing the opacity of the letters’ glow
makes them more visible against the light background.
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A The Preview Area shows a sample of the
PhotoGlow options before you apply them to
your image.

B The Glow Type pop-up menu provides two
options:
Edges applies the glow effect to the area
defined by the selection edges of the selection.
Solid ignores enclosed selection areas within
the selection area. Solid fills in the hollow areas
like the center of a selected “O.”

C Stroke Width controls the number of pixels from
the image that the glow extends. A higher
number indicates a fatter glow.

D Radiance indicates how abruptly the outer edge
of the glow diffuses. A high number indicates
higher diffusion.

E Opacity indicates the percentage of the glow
that is allowed to be seen in the image.

F The Color pop-up palette includes an
assortment of colors, access to the Photoshop
background/foreground colors and the Apple
Color Picker. The color that you select
determines the color of the glow.

G See the entire image in the Preview Area when
the Preview Work Area Only checkbox is not
selected. See only the selected part of the
image when the checkbox is selected. Selecting
the checkbox increases preview refresh
performance.

H Selecting the Auto Preview checkbox
immediately shows changes to your created
effect. The Preview Now button is only active
when the Auto Preview checkbox is not
selected. When you click this button, the
Preview Area updates.

I The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved glow sets appear in the
Glow pop-up menu. Selecting a saved effect
displays its settings in the dialog box. You can
then apply these glow settings to the current
image.

J Zooms in and out.
K The Apply button adds your created effect to

the image and closes the Glow dialog box.
L The grow box resizes the dialog box and
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The PhotoGlow dialog box
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PhotoShadow
PhotoShadow provides the ultimate drop shadow creation tool. Shadows
give flat images a 3-dimensional, raised appearance. Use PhotoShadow to
quickly create a variety of shadow effects and apply them to the current
selection. You can even save any shadow style you create and use it again
on another image.

Features of PhotoShadow include the ability to use the selection area’s
“bounding box” or its edges to create a shadow. You have control over the
distance that the shadow will offset from the image. (The shadow will be
the same shape as the selection.) In addition, you have control over the
amount of shadow blur and opacity. As you adjust the Shadow settings,
you can preview the image in real time or on demand before you apply the
shadow to the image.

A The Preview Area shows a sample of the
effects before you apply them to your image.

B The Shadow type pop-up menu provides two
options:
Edges applies the shadow effect to the area
defined by the selection edges of the selection.
Solid ignores enclosed selection areas within
the selection area. Solid fills in the hollow areas
like the center of a selected “O.”

C X Offset (pixels) establishes the number of
pixels to the left (negative number) or right
(positive number) to offset the shadow from the
image.
Y Offset (pixels) establishes the number of
pixels up or down to offset the shadow from the
image.

D Blur controls the amount that the shadow is
blurred. A higher number indicates a stronger
blur.

E Opacity controls the shadow’s translucency.
100% is no translucency.

F The shadow Color pop-up palette includes an
assortment of colors, access to the Photoshop
background/foreground colors and the Apple
Color Picker.

G See the entire image in the Preview Area when
the Preview Work Area Only checkbox is not
selected. See the selection plus a little when
the checkbox is selected. Selecting the
checkbox increases preview refresh
performance.

H Selecting the Auto Preview checkbox
immediately shows changes to your created
effect. The Preview Now button is only active
when the Auto Preview checkbox is not
selected. When you click this button, the
Preview Area updates.

I The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved shadow sets appear in the
Shadow pop-up menu. Selecting a saved effect
displays its settings in the dialog box. You can
then apply these shadow settings to the current
image.

J Zooms in and out.
K The Apply button adds your created effect to

the image and closes the Shadow dialog box.

The PhotoShadow dialog box
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Tip

Holding down the Option key
with the mouse over the
preview will turn the Hand tool
into an Arrow tool that allows
you to interactively adjust the
X/Y shadow positioning.
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